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Tracking your issues using Power BI
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Learning Objectives
•
•
•
•

Learn how project issues can cause various problems when not addressed early
on.
Learn how to bring issues into Power BI using a variety of different data sources.
Discover how to present data in an actionable way.
Discover how data visualizations are created and combined with multiple data
sources.

Description
Whether it is Navisworks software, Revit software, or a highlighter, tracking project issues is
important. In this course, we will learn how you can use Microsoft Power BI to track project
issues in a very graphical way.

Speaker(s)
Brian Myers has industry experience that spans the Architecture, Engineering, and Construction
trades. This experience includes a variety of duties including BIM management, project
planning, staff mentoring, technology and process development, and a diverse background in
the various design disciplines. These efforts span multiple offices in person, remotely, and
virtually.
He has worked in industry types that range from medical facilities to federal projects (offices and
military) to material and food processing plants to commercial buildings to site development.
Brian is best known outside of his local influence (which includes public speaking and user
group engagement) for his extensive video work for LinkedIn Learning (1,700+ industry process
videos) and his development of the two largest Revit LinkedIn Groups which are approaching
150,000 members and 45,000 members, respectively. Additionally, he enjoys mentoring and inperson teaching.
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Power BI and understanding the Power of Information
While the “I” in Power BI stands for (Business) Intelligence, it’s really the intellectual capital of
individuals that Power BI is leveraging through its unique tools to visualize information that
provides the value. In fact, Microsoft is so aware of this fact that they actually call the tools used
to visualize information in Power BI, Visualizations. Now if you are new to Power BI that is just
fine! In fact, it can be downloaded for free from Microsoft’s website and I even used the free
version for creating this class. The version I used? It’s called Power BI Desktop. If you want to
do better presentations of your information, you won’t regret downloading it.

Power BI and Project Issues
A project issue can mean many things to many people. For contractors those could be clashes
they find in the field, for design engineers it could be coordination issues they have with other
design trades. For the client? An issue could be just about anything that goes wrong in a
project, including misunderstandings that happen when information is not communicated
properly. Ultimately, an issue is just what it sounds like… it is something you are going to need
to deal with or have others deal with. There needs to be better ways to communicate these
issues so that we can solve them before they become larger, more costly problems. That’s
where Power BI comes in. In this course and document and will focus primarily on “clash”
issues where objects hit each other, but I will also mention other issues along the way and
solutions for them.

Bringing Issues into Power BI
For starters, Power BI is capable of bringing in a vast amount of information sources. I compare
it to being the Navisworks for Information. Data types incude, but are not limited to:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Excel
SQL Server
Text Files
JSON
PDF
Access
Azure
Sharepoint
Salesforce Objects and Reports
Websites
Microsoft Exchange
ODBC
Python script
OLE DB
…. And much, much more.

My personal favorite? While I admit I use Access whenever I can and we have Sharepoint at my
work, my favorite files to bring in are typical Excel files. I’ll use them exclusively for this
demonstration because just about everything that is data driven can export to something you
Page 2

can bring into Excel. In my case, I will be bringing XML, TXT, and HTML files all into Excel for
formatting.

Revit Export
This is where it gets to be interesting for me as there are several ways to get the data into
Power BI from Revit. The “data” not being the drawing, at least not yet, but the information from
Revit. The first way is to create a Schedule. After creating a schedule with all the information
you require to display in a Power BI visualization (Example: a Room Finish or Space Planning
schedule) you can Export that information out as a TXT file.
Go to FILE (or the “Big R” in older Revit versions) – Export – Reports – Schedule. Then choose
where you can save your comma deliminted Text (TXT) file into. This is EXACTLY what I did in
this course when I bring in my Space Schedule with the various space names. Technically I
could have brought the TXT file directly into Power BI, but I opened it in Excel first, saved it as
an Excel file and then brought it in. Excel is a bit more forgiving when it comes to formatting
data, so it’s best to use it for that purpose.
Alternately, you can save it to an ODBC database. This exports out a SUBSTANTIAL amount of
information, which is good and bad. It’s good because it gives you a lot of choices. It is bad
because it takes a while…. And gives you a lot of choices. To export to ODBC:
Go to FILE (or the “Big R” in older Revit versions) – Export – ODBC Database. Then follow the
prompts. If you don’t know how to use this already, don’t do it!
OK, you can. But teaching how to set that up and use it will take an entirely different class.
Really, those instructions are for those database people out there and the database people in
your life. It is a really nice choice, particularly since Power BI can bring in just the data you
select once the database is created.
Now for the primary way I did the export for this course…. I exported to Navisworks Manage. It
is a lot of the same steps, but allowed me to do the clash detection before bringing the data into
Power BI.
Go to FILE (or the “Big R” in older Revit versions) – Export – NWC. Then follow the prompts.
….. and now’s the time to Export from a different software. Navisworks Manage.

Navisworks Export
Just doing a Navisworks Export at this point really would not help you. Instead, you need to
open the NWC file then setup the Clash Detective first.
First start an empty Navisworks project. From under the Home tab on the ribbon select the
Append button. Find the Navisworks NWC file you exported, click it, then select the Open
button to load it into the software.
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Now that it’s in Navisworks, you can setup your clash detection features to find Issues!
If not already open, click the Clash Detective button from the Ribbon under the Home Tab in
Navisworks. Alternately, go to the View Tab on the Ribbon and select Load Workspace. Select
Navisworks Extended. This will make Navisworks look like it just crashed. The good news is
that it just closed to open up again with a lot of extra tools, including Sets and the Selection
Tree. You’ll need them too.
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On the left side of the screen you will see some tabs. Click the Clash Detective, then click the
little push pin in the upper right corner. That will keep it open. Do the same thing for the
Selection Tree and Sets.
While I won’t make this a full blown Navisworks course, I will mention the basics going forward.
In the Selection Tree you should see the file you appended. Click the little Plus ( + ) sign to the
left of the file. Keep doing that until you see the major object category types for each Level of
your building.
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When it looks something like the above, except with each level open, start to think about what
you want to run a clash test on. A clash test allows you to see when objects are hitting each
other that should not be hitting or touching each other. Click each category under each level
you want to add to a standard selection set of similar objects. For example, you may choose to
select Ducts, Duct Fittings, and Air Terminals if you are creating a “set” for your Mechanical or
for your HVAC in general. You can select multiple by holding down the CTRL key on your
keyboard. I usually break it down extensively based on who will be creating the design and what
they need. For simplicity sake, I created only a few sets for my example for AU.
Oh, creating a Set. That’s what you are getting ready to do.
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When you have your similar items selected, click the button on the far left of the Sets dialog.
This will create a new set based off of the items you selected from the Selection Tree. Give it a
name. Keep doing this for each category you want to create Clash tests for.
So in review, you Selected items from the Selection Tree to put in a set of objects together
under Sets. Now anytime you click on the Set in the Sets dialog box all those objects you
selected before will be selected.

Navisworks Clash Detection
Now’s the time I’m finally going to be a little vague, as I’ve taught Naviswork courses for an
entire day and clash detection over 90 minutes, which is longer than my AU class. But here’s
the basics.
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For one time only, in the Upper Right corner of the Clash Detective, you will see a button to
create a Test. Select it. From here on out you will need to select a different button, called Add
Test, right above the Rules tab in the Clash Detective, about half way down the screen.
Do this process multiple times. When “done” click where “Name” displays and rename each test
you just created to something you want to test for. In my example I created tests for each
discipline/trade against each discipline/trade.
Once you have done that for every clash detection you want to setup, go down to your tab
called Select.
Notice in the image above the Left and Right side are called Selection A and Selection B?
Click the Pulldowns right under those words. Sets, if you created them like I asked, will now be
available. Now all your hardwork is about to pay off.
First, up above, click the first Clash Test you created. Now move your mouse down and on the
left (under Selection A) select the first set you want to clash and on the right select the set of
objects you would like to see if they hit against. That’s it. Once both sets are highlighted, click
the next Clash Test and do the same thing…. Again, and again, and again. When finished, you
will have you clash tests ready to go!
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At the botton of this dialog you can now select the big button called Run Test. It will run all of
them and give you your results. To see your results, just select the Results Tab if it does not
automatically switch you (it likely will).
By clicking on the tests you created up above you will be able to scroll through all the clash test
results you created. These can be cleaned up further, but that’s for a different course. For now,
you just want the results.
Next, select the Report tab.

FINALLY getting there……
OK, that was a lot of work, but you had to do it anyway. So now we are going to Write Report,
but first you need to know a different set of buttons.

For what WE care about in this process, these are some of the most important button we need
to worry about. OK, the clash results are more important, but these buttons allow you to export
the clash results.
Report Type: If you click this button you get two primary options, All Tests (separate) or All
Tests (combined). We will talk about which to use later, but both can be important. They do
what they seem like they would do, export all the tests individually or all combined in one report.
Report Format: I have seen 4 of the 5 used for what we are about to do. XML is my favorite,
but not always my choice. HTML (Tabular) can be brought into Excel and then brought into
Power BI. Text can also be brought into Excel, so it’s not a bad choice either. As Viewpoints… I
wouldn’t use, at least not yet. Technically you can mine the data out of it if you are good with
Querry editors, but it’s a chore and not worth the effort most of the time. The only one I wouldn’t
use is the one I use the most often to just print directly from Navisworks, HTML. (Without the
word Tabular). It’s not ideal to bring into Excel or Power BI, so we’ll just leave it be.
If you’ve followed me this far, make a folder somewhere you can find it again and save your
report to that folder as an XML file. I recommend creating an All Tests (combined) report and
clicking the Write Report button.
Open the XML file in Excel (or Power BI, but I still recommend Excel) and save it as an Excel
file.
Congratulations, you finally have some data to use! OK, technically you could have used an
Excel spreadsheet (such as you might get from a client or a person that does everything in
Excel) but what we created is way more useful and gives us what we need too.
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Power BI Desktop
When you open Power BI you may get an opening “splash screen”. No need to select any
options if you do, just click the “X” in the corner of the window to close that dialog.
In the blank Power BI document, start by linking your data into Power BI.

Under the Home tab you will see some options. If you saved everything to Excel then great, all
you need to do is click the Excel button and start selecting files. Open them like you would any
other file. At first you may not notice what Power BI is doing other than processing the data, but
in the Fields dialog (right side of your screen) it is bringing each file you created in. If you did
NOT convert your files in Excel, you will need to select the Get Data button and find the file type
you created. Then let Power BI bring them in. There is nothing wrong with that, but once again if
you are used to Excel you’ll find Excel easier to use to clean up your data should you need to do
that. When I say “clean” your data, that could be the format of the data or just getting rid of extra
information you will never want in a report.
If everything goes as planned you should be able to click the little “down arrow” next to the
name of the Sheet or Tab or data you brought in (Under Fields on the right) and see all the data
fields.
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Before you start clicking random check boxes next to the data you want to see (you did already,
didn’t you?) go to the dialog next to Fields called Visualizations. Each one of those is a different
graph, chart, or whatever that you can use to create pictures of your various data fields. The
last one, a button with 3 little dots, will take you online to download more from Microsoft.
My favorites? It varies, but I would pick:
•

Table

OK, Table pretty much does it. The Bar Charts, Line Charts, Scatter Charts, etc all get used
and have great applications for displaying data, but if I can read you had 500 clashes, 780
clashes, 340 clashes, 34 clashes in consecutive weeks and put those numbers up against other
disciplines, I don’t need a few long, short, circular etc graphics that do the same thing. Or
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maybe you do. Pick the one that best serves the audience you intended to read your data. For
me, Table works most of the time with an honorable mention to Slicer which enables you to
“slice” or parse your data so you only see the data you request. Here’s an example, where
Room Finder is Slicer and Rooms and Levels is just a chart. BUT when you select the Level in
Room Finder (Slicer) it automatically updates the chart with the rooms and room data from that
floor.

Play with these for a while and if you don’t like one, no problem, just select it and pick a different
visualization. That being said, it may be hard to “play” with these until you know the secret
buttons for success.

Discovering the Visualizations Secrets
Visualizations are great and many are different from each other, making it tough to talk about
each one. That said, the following are areas you need to know about so that you can customize
and view your Visualizations the way you want to see them.
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First, notice that little Paint Roller icon under the visualizations. That is the visual properties of
your visualizations. It gives you the ability to see everything from Visualization title with different
size fonts and collors to providing your graphics themselves with different color schemes. It allos
you to underlay shadows and even create custom tooltips to guide your visitors. If you need to
change the way something appears, this is your area. By the way, a page back when I
mentioned Slicer and the Table, the Headers are black with white text because I changed them
here.

Page 13

While Filters can look DRASTICALLY different from Visualization to visualization, they do tend
to have things in common. In the image above, notice where it says “Add data fields here” and it
has that message in several spots. Click and drag your fields from the right into the proper spot
under Filters. That’s a big thing to understand. If you filter the VISUAL then that field will add its
data to the visual you chose. If you do it by PAGE it will filter not just the visual, but the entire
page. If you filter ALL PAGES then it will filter every tab (page) in your document. Wonder why
suddently your entire document only has 3rd floor information? You guessed it, somewhere you
are filtering the entire document by 3rd floor. In short, if your visual is not displaying what you
want in terms of information, 80% of the time it’s because your Field is in the wrong Filter slot.
BONUS INFORMATION:
Often the problem is not under fields, it may be under VALUES instead. Values is the little icon
to the left of the paint roller.
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Above you can see that Number, Name, and Level display under Values. In this case that’s
what is running the visualization. The filter then applies itself to this data.
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Related to what I typed a moment ago, you can now see that Level, Name, and Number are
also now under Filters. If you click on them you get some of the real power of the software. You
can filter by certain levels, or names, or room numbers, or any other data you can filter by. This
allows you to drill down in your data and create the specific visualizations that you require.
Finally, while you can see my interactive report in the video for this presentation, I will also be
uploading a PDF of it as well as a supplemtary document. Feel free to flip through the PDF and
see the high quality output Power BI can create. (FILE – EXPORT – EXPORT TO PDF)
Good luck!
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